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Overview

Ove

rview

Version 9.2.5 is the latest release being made available to customers to provide functionality and address some
known issues.

Impo

rtant

9.1.0+ uses a new GUI format. FortiNAC cannot go backwards to a previous version. Snapshots should
always be taken on virtual appliances prior to upgrade.

Prior to upgrade, review the FortiNAC Known Anomalies posted in the Fortinet Document Library.

If using agents or configured for High Availability, additional steps may be required after upgrade for proper
functionality. See Upgrade Instructions and Considerations posted in the Fortinet Document Library.

Requires CentOS 7.4 or higher. The current CentOS version installed is listed as "Distribution” in the CLI
login banner or typing "sysinfo".

Example:

> sysinfo
khkhkhhhkhkhhhkhkkhkhkkhkkhkkhhhkhkhhhkhkhAhrhk bk drrr bbbk bk hkhkhkhhkkhkkhkkhhkkhkhkhkhkhkhkrdrhkhkrrrhkhhhhhkhkkkkkx*
Recognized platform: Linux

Distribution: CentOS Linux release 7.6.1810 (Core)

If the CentOS version is below 7.4, run OS updates and reboot before upgrading. For instructions on
updating CentOS, refer to the Fortinet Document Library.

For upgrade procedure, see Upgrade Instructions and Considerations posted in the Fortinet Document
Library.

Supplemental Documentation

The

Versi

The

following can be found in the Fortinet Document Library.

FortiNAC Release Matrix

on Information

se Release Notes contain additional Enhancements, Device Support, and features. Unique numbering is

used for the various components of the product. The software version and Agent version supplied with this
release are listed below.

Version: 9.2.5

Agent Version: 5.3.0.77

A newer Persistent Agent may be required to support certain antivirus and anti-spyware products. Refer to the

Age

FortiNAC 9.
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nt Release Notes in the Fortinet Document Library.
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Overview

Firmware version represents a collection of system services and operating system features imaged on to the
appliance before it leaves manufacturing. The firmware image cannot be updated by a Fortinet customer.
Services within the image are updated by Fortinet or a certified Fortinet Partner in appliance maintenance
packages released as new more robust and secure versions of services become available.

Note that upgrading software versions does not change firmware nor does it automatically require an upgrade to
the Persistent Agent. Newer Persistent Agents are not compatible with older software versions unless that
capability is specifically highlighted in the corresponding release notes.
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Compatibility

Compatibility

FortiNAC Product releases are not backwards compatible. It is not possible to go from a newer release to any

older release.

Example: 8.1.1.132 cannot be downgraded to any other release.

To backup the current system prior to upgrade on virtual machines, perform a snapshot. For physical
appliances refer to the document Back Up and Restore an Image of a FortiNAC Appliance.

Agents

FortiNAC Agent Package releases 5.x are compatible with FortiNAC Product release 9.x. Compatibility of Agent
Package versions 4.x and below with FortiNAC versions 8.x and greater are not guaranteed.

Web Browsers for the Administration Ul

Many of the views in FortiNAC are highly dependent on JavaScript. The browser used directly impacts the
performance of these views. It is recommended that you choose a browser with enhanced JavaScript

processing.

Operating Systems Supported Without an Agent

Android Apple iOS
Chrome OS Free BSD

iOS for iPad iOS for iPhone
Mac OS X Open BSD
Solaris Symian
Windows CE Windows Phone

FortiNAC 9.2.5 Release Notes
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Blackberry OS
Kindle

iOS for iPod
Net BSD

Web OS
Windows RT

BlackBerry 10 OS
Kindle Fire

Linux

RIM Tablet OS

Windows



New Features

New Features

New Features in 9.2.5 . . ..
New Features in 9.2.4
New Features in 9.2.3 ... ..
New Features in 9.2.2
New Features in 9.2.1 . . ..

New Features in 9.2.0 .. ... .

New Features in 9.2.5

There are no new features in version 9.2.5.0443.

New Features in 9.2.4

There are no new features in version 9.2.4.0438.

New Features in 9.2.3

There are no new features in version 9.2.3.0435.

New Features in 9.2.2

There are no new features in version 9.2.2.0421.

New Features in 9.2.1

There are no new features in version 9.2.1.0414.
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New Features

New Features in 9.2.0

» Enhanced Appliance Installation: Login to the Administration Ul in order to apply license key, configure
appliance network settings and the FortiNAC Service Interface (eth1). There is no longer a separate Ul.
 Ability to add Custom Endpoint Fingerprints using the REST API.
+ New Endpoint Fingerprints view (Replaces Device Identity view) and Tasks view.
» Local RADIUS Server Enhancements
o Updated views including configuration subsections
o Multiple virtual Local RADIUS Servers
o Multiple Winbind instances
o Improved debugging tools
o Improved visibility of services and configuration
°  Added support for EAP-FAST in FreeRADIUS to the extent possible:
Configurable EAP-FAST controls:
= PAC Opaque Key
= Allow Anonymous In-Band PAC Provisioning
= Allow Authenticated In-Band PAC Provisioning
+ Dashboard Rework

» Multiplicity - Multiple Dashboards may now be created and the name may be freely modified.
Dashboards may have multiple instances of each Widget.

» Layout and Sizing - Widgets (formerly known as panels) are rendered in a row with a number of
columns available based on the screen size. The row wraps automatically, filling from the left. All
Widgets have a fixed height, but user adjustable width set to the number of columns they should span.

» New Tiles for Pending Tasks and Endpoint Fingerprints.
» Persistent Agent Enhancements (Agent 5.3)
o Agentincluded in FortiNAC 9.2
o Agent fingerprints are now visible in the Endpoint fingerprints view
o See 5.3 Agent Release notes for details and other enhancements
+ FSSO Enhancements
o User definable network address objects and address groups for SSO messaging.

o Support for managing hosts with PA installed but not seen as connected by FortiNAC by a managed
device.

o Support for new dynamic firewall address API that will replace the FSSO protocol in FGTs running
FOS7.0.2

+ Netflow protocol support added for Device Profiling..

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Enhancements and Addressed Issues

These changes have been made in FortiNAC Version 9.2. These enhancements are in addition to the
enhancements that are outlined in previous releases.

Version 9.2.5

Ticket # Description (9.2.5.0443)

726333 Entitlements (such as concurrent licenses) for Subscription Licenses are
not accurately reflected in the Administration Ul License Management view
and only show Base licenses.

733943 Changing password in bulk using Set Model Configuration sets the same
username for all selected devices

747921 Portal renaming does not rename the associated CSS files.

751393 UserManager NullPointerExceptions.

770974 Event Lifetime alarm trigger rule is not being honored when configured.

781520 RADIUS COA failing for FortiAP when hosts are deleted.

783587 AirWatch MDM roles are overwritten by user roles.

786651 Improved support for MICROSENS G6 Micro-Switch.

787271 Certificate Management View - Server Certs & Trusted Certs views both

showing results from both views.

789970 FortiNAC sends SSO login message to only one slot on the 6000 & 7000
FortiGate chassis.

791405 "Request unsuccessful with no errors reported" message opening Model
Configuration tab for HPE Walljack.

794067 Support for new "show clients" table format in version 8.X Aruba IAP
firmware.

794381 Fortigate forwarding class does not work with tlsv1.3.

795260 Motorola controllers proxying AP auth requests send Proxy-State attr and

expect it unchanged in response. RADIUS (local) does not send it back.

796065 Unable to set device profiling to Host to Logged in User (if Present) on
NCM.

796522 SocketTimeoutException in logs related to Telnet/SSH connections.

796533 Support for Physical Ethernet MAC for Apple TV in Jamf.

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

796623 MS Intune API only returns ethernetMacAddress per device.
797708 Force 10 switches sometimes modeled incorrectly.
797723 Local RADIUS mode:RADIUS fails for endpoints connecting to a

FortiSwitch that has been renamed.

798181 RADIUS Service Host MAC filter does not print debug if supplicant does not
use colon mac delimiter.

800408 API query for FLink FSW data deprecated in FOS 7.2+.Prevents
FortiSwitches in Link mode from being added to Inventory when the
managing FortiGate is discovered.

801252 RADIUS not mapping to correct AD server when kerberos and netbios
names differ for a single winbind instance.

802114 Juniper EX9253 and qfx5120-48y-8c, Type is "Unknown" and Version is
null in the Inventory.

802923 ClassCastException when creating/deleting trigger.

802942 Parsing issue with Mobile Iron Cloud integration.

803061 Multicast IPv6 addresses can now be excluded using the MAC address

Exclusion view. See MAC address exclusion in the 9.2 Administration
Guide for details. Note: After upgrade, toggle the option off and on in order
for the function to take effect.

804518 Local Radius leaves out Tunnel-Private-Group-ID and Filter-ID when
Quarantine enforcement is set to "bypass”.

805866 Scheduled Shared Filter Reports result in error event.

806122 Roles not being assigned properly to Registered Hosts

806567 known_hosts file has duplicate host entries.

806616 RADIUS COA failing for a variety of devices when hosts are deleted.

807062 On upgrade, FortiNAC loses it ethO IP Address.

807689 For endpoints managed in SSO integrations, FortiNAC no longer performs
L3 polls for Rogue hosts. They are not neccessary.

801948 New deployed server will not start: java.sql.SQLException: Connections

803681 could not be acquired from the underlying database.

809538 High Availability Database sync failure

810167 Fixed fingerprints foriOS, FGT and FSW

810180

811008 Netgear mib file has a feature to write a "hidden" field for Username and

Password which is not supported in 9.2.

FortiNAC 9.2.5 Release Notes
Fortinet Inc.
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Enhancements and Addressed Issues

807311 After FortiNAC services restart, MAB RADIUS session times out due to
FortiNAC being busy in SSH communication with the switch.

812169 Virtual Winbind service management queries periodically fail.

802908 RADIUS default server config not created on first startup.

805426 Fixed Null Pointer Exception in dynamic/dynamic-connection/host/{id} API
call.

790864 License upload does not verify MAC/UUID.

812589 Server doesn't start up / cannot log into FortiNAC UI.

811447 Upgrade failed due to: Operation CREATE USER failed for nac@localhost.

Version 9.2.4

784618 RADIUS Failures after upgrading from 8.5 to 8.8 due to bad secret.

791327 FortiNAC is changing WAP Uplink ports Current VLAN to match the Default
VLAN.

797465 Nested group memberships not detected.

797778 AdminProfileManager has a null reference on Startup

799842 Endpoint Compliance - Policies: Takes 30 seconds to create policy,

exception occurs due to user clicking OK more than once

Version 9.2.3

769558 NullPointerException registering a rogue host from the Hosts View.
640841 SSH connection to some AlaxalA switches fail.

741373 Support for Mobile Iron V2 API

746585 Cisco Mac Move Notification Trap support.

750248 Unable to access the secondary server's Configuration Wizard in a High

Availability configuration.

752792 Device Profiling Rule registration not setting user/group membership.

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

753937 "Run NMAP" is now an option under Users & Hosts >Endpoint Fingerprints
in the UI.
754279 Host record marked "At Risk" due tothe generation of the "Persistent Agent

Not Communicating" alarm fail to be marked "Safe" after "Communication
Resumed" is generated.

754605 Added Tripp Lite DHCP fingerprints
758009 Added support to change VLANSs via CLI on Allied Telesyn 8000S.
759018 Admin user with admin user profile permissions to Access, Add/Modify and

delete "Users" is unable to create a new regular user.

761276 User/Host Profile with Location does not use Portal defined in Portal
Configuration.

762071 Radius Auth/EAP Type columns empty in Network > Device > Ports >
Adapters table.

762081 bsc-rename-ethers service fails on virtual machines.

762702 Improved FortiClient EMS polling.Previously, not all hosts were retrieved
upon a poll, causing some hosts not to register.

765477 FortiClient EMS test connect still fails after correcting a credential mistake.

765483 Fortinet EMS Version parsing is broken for EMS 7.0.

765899 EMS integration does not take into account theignoredAdapters.txt list.Can
cause Adapter/Host record generation with Fortinet virtual adapters.

766600 L3 polling support for Inhand IR915L Router

767209 Aerohive VLAN interfaces do not update on resynchronization after VLAN
ID or Profile ID change.

767942 Incorrect serial number used for CSF protocol used for SSO.

768329 Fail to determine port type for Cisco SG Switches with latest Cisco
firmware.

768673 OS name for OS X devices between DHCP and Fortiguard fingerprints do
not match.

768785 The GUI value "Registered Host" now displays as "Registered Host With
Owner".

768793 Race condition causing StaleStateException in FirewallSessionManager.

768822 FortiSwitch does not respond to Change of Auth (COA) packet due to

FortiNAC not sending the correct secret.

769851 Accounting Stop Message is discarded from Link Mode FortiSwitches when
using Local Radius.

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Ticket #

770034
770192

770208
770548
770562
770695

770730

770738
770830
770930

771038

771149

771157

771422
771506

771685
771705
771743
771939

772010

773053

773828
773841

FortiNAC 9.2.5 Release Notes
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Description (9.2.3.0435)
FGT 1800F labeled as 1500D

Device Profiling rules stop processing as expected if HTTP method is used
and HTTP is timing out.

Juniper switches fail to change VLAN on ports that are RADIUS enabled.
Operating System custom attribute does not save in Device Profiling Rule.
Device Profiler is performing all scans before checking for matches.

Local RADIUS fails to find correct port on Extreme Summit X, preventing
proper VLAN assignment.

Local RADIUS service goes down & does not restart when FortiNAC
processes are restarted.

Ruckus API version detection not working for login API

Device Rule Confirmation Failure event is not generated for some methods.

High L3 Polling frequency in environments with no SSO management
configured.

Port state actions without clear actions cannot be saved in the Event to
Alarm mapping.

"Confirm Device Rule on Connect" does not work properly when "Confirm
Device Rule on Interval" is also enabled within the same Device Profiling
rule.

Mobilelron Cloud application poll can fail if licenselD is too long.
RFC 3576 (CoA/RADIUS Disconnect) support for Extreme switches.

Erroneous creation of redundant unique keys could overfill Group table key
limits.

Apresia integration RADIUS 802.1x support incomplete.
Change Inhand mib file to not use WRITE_HIDDEN in 9.1. and 9.2.
FSSO tags not sent to FortiGate with multi-VDOM Fabric Connections.

Automatically detect MAC format for RADIUS CoA requests for Juniper
switches.

Wireless clients are not correctly processed on FortinetAPs when using
some multi-vdom configurations.

RADIUS not mapping to correct AD server when Kerberos and NetBIOS
names differ.

Not polling L2 information from PNetworks switches with latest firmware.

Meraki Switch VLAN read/set fails when the iflndex does not match the
dot1d index.
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)

774202 Adjusted timestamp in syslog CEF message format.Previous formatting
prevented some systems from properly processing syslog from FortiNAC.

774724 Unabile to filter Hosts and Adapters by status through API.

775973 Option to prevent auto-logging on users during authentication is absent
during L2 polling.

776123 Unable to add/modify groups starting with "!" (bang).

777124 A higher ranked policy more general than a lower ranked policy is still
honored if disabled.Lower ranked policy displays with a strike-through and
is ignored.

777126 Invalid MAC address doesn't skip non-matching OUI Method.

777400 Syncing "Role Based Access" group on the Control manager (NCM) may
delete sub-groups on the synchronized POD.

777479 Control Manager (NCM) Dashboard tile is very slow to load.

777511 RADIUS support for HP 2910 and 2920 switches.

777778 Unable to switch VLANSs on Juniper switch via 802.1x RADIUS in Proxy
mode.

778108 Windows domain check Device Profiling method fails if there is no domain

user logged on.

778112 Performance issue when performing group membership
lookups.Symptoms include usually high CPU utilization.

778157 L2 Polling issues with Cisco 9800 WLC firmware 17.3.

778520 Added SQL query for GroupManager.getGroupsMembershiplDs() when
determining group membership in order to improve performance.

779873 FortiNAC processes taking unusually long to startup due to delays
resuming FirewallSessionMgr.

779901 Vulnerabilties in mysql versions less than 5.6.42.

780282 FortiNAC Events using old vendor name "Bradford Networks".

780626 Huawei Wireless controller imports nameless APs.

780790 CLI Failing to Alcatel Omni 6860-P48.

782374 L2 polling not parsing correctly for Motorola 7.X devices.

782740 Unable to read default and current vlans for Ruijie switches.

782744 Script install-winbind-virtual contains spaces around = assignments -
invalid

783227 Operating System updates from the Ul fail when freeradius gpg key is not
present.

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Ticket # Description (9.2.3.0435)
783544 Fortigate FG-200F improperly labeled as FG-201E.
783552 nac.service / ProcessManager not running at startup when no IP on box,

leads to processes down.

783621 Host import related Memory issues.

783944 Exception reading VLANSs or SSIDs on Meru 4100 with firmware 5.1-93.

784601 Group membership lookup causing high CPU utilization.

784957 Not polling L2 information from Cisco ME-3400E-24TS-M router.

786401 Remote Scan -> Linux x86_64 -> 500 Error

786434 Allow changing CLI Passwords from Secondary and Application Servers.

786751 Added Distinguished Name (DN) field in Users View table.DN can now be
used as a filter.

787562 Devices registered with incorrect icon type in MDM integration.

787563 NullPointerException (NPE) during L2 poll of Meraki.

787585 DHCP fingerprints are not matching DHCP message type.

788089 RADIUS service will not start after upgrade to 9.2 if winbind is not fully
configured.

788825 DHCP fingerprint additions, changes or improvements.

Added: "Camera","D-Link"; "Camera","TRENDnet"; "HVAC","Honeywell"

Updated: "Mobile","Samsung SmartWatch"; "Gaming","Nintendo";
"Network","Router/Netgear"; "Network","Router/D-Link";
"Network","Router/Trendnet"

Changed Device Type: "Network","Apple TV" -> "internet_tv","Apple TV";
"Network","Amazon Fire TV" -> "internet_tv","Amazon Fire TV";
"Network","Chromecast" -> "internet_tv","Chromecast";
"Network","DIRECTV" -> "internet_tv","DIRECTV"; "Network","DVR/TiVo" -
> "internet_tv","DVR/TiVo";

"Network","Roku Media Player" -> "internet_tv","Roku Media Player"

790403 ClassCastException in AirespaceSwitch during WAP read.
790747 FortiGate interface with VLANs does not show device connections to VLAN
sub interfaces for device detection traps.
0784737 0785526 Location and IPRange method match failure prevent matching lower rank
rules.
788729 RADIUS 802.1x proxy intermittently stops working.
FortiNAC 9.2.5 Release Notes 15
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Enhancements and Addressed Issues

791342 Manually Registered IP Phones get incorrect device type assigned.

758009 SSH access fails to Allied Tellesys AT8000S.

782433 Fix Integration for D-Link DGS-3130-30TS.

790854 Failure to properly read Cisco trunk ports results in undesired VLAN
switching.

791304 Selecting "Uncheck All"in an Admin Profile removes General permissions.

791401 By Day grouping is incorrect under Dashboard > Scans.

794362 System Update not reliably trusting fnac-updates.fortinet.net

791276 Clicking EULA Link When Logging In As New User Goes To Broken Link.

793920 Default Admin Profiles Have No Permissions

782760 Huawei S7706 switch does not correctly reflect the interface port number in
Label column.

796105 Device Type incorrectly changing for registered devices.

Version 9.2.2

Ticket # Description (9.2.2.0421)

566257 Huawei wireless controller integration

609121 Support reading new SSID table format for Aruba IAP.

723743 Unable to change VLANSs on Cisco 9500 switch with
TwentyFiveGigEthernet ports.

742523 LDAP server shows up as a rogue host icon in Topology/Inventory.

749846 Evaluation Time and High Availability tooltips are undefined in the License
Management view.

750597 Registered Topology devices appear as rogues in Endpoint Fingerprint
view.

750617 Add a column to Fortigate Sessions for Netflow/Sessions source.

753384 FortiNAC REST API: Added an optional boolean for "add-to-parents" that

determines if doing an add or replace.Previously, would remove existing
group membership unless both existing parent group and new parent group
IDs were specified.

753385 FortiNAC REST APIl:Add-members now able to add a group to another
group of same type (Host, User or Port) using Group ID.

753662 Telnet/SSH timeouts can now be configured per device from the CLI or from

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

753923

754212

754261
754619
754700

756299
756527
757705
757749

758282

758514

758535

758976

759181

759243

759245

759280

759709
759768

760197

760394
760409
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Description (9.2.2.0421)

the “Credentials” tab in the Ul.

Clicking Create Device Profiling Rule in FortiGate Sessions view only
displays FortiGate and Network Traffic as options in Methods tab.

Security events not always resolving IP to MAC, resulting in inconsistent
security event generation.

ForceSSO attribute not retained after upgrade to 9.2.
Hosts CSV files with rule names could not be cleanly imported.

NetFlow processing may sometimes attempt to remove already removed
records.

Global option for changing the scope of target FortiGates not working.
DPC revalidate doesnt resolve MAC-to-IP.
Legacy SSO requires tags to be configured even though they are not used.

Added REST API support for Ruckus v6.0.Previously, wireless clients
connected to Ruckus were inaccurately showing offline in FortiNAC.

DeviceManager NullPointerException

Support for new REST APl introduced in FortiGate version 7.0.3.
Improved performance of CSV imports.Previously, import was very slow.
Rebooting FortiNAC takes a long time due to FirewallSession table.

Improved event storage management.Previously, databases had the
potential to grow unsually large, causing issues with upgrades and
database replication in High Availability environments.

Fixed 'RadiusServer failed to intialize' message (typo and repeating
unnecessarily).

DHCP fingerprints:Updated Wii and added definitions for LG internet TV
and PS5.

Host details aren't updating as expected when there are multiple
fingerprints per source (such as a dual-boot system).

Create Winbind instance - Returns error, throws NullPointerException

RADIUS disconnect not sent for Juniper wired switches when using
RADIUS authentication.

macOS Monterey hosts running the Dissolvable Agent are unable to obtain
configuration from server.

Device Profiling is failing if FortiGuard method is used with higher rank.

Cannot L2 poll Ruijie switches.
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Enhancements and Addressed Issues

760424
760596

760616

760861
761362

761623

762240

762421

762438
762456

762743

762963

764011
764415

764518

764818

765187

765227
765252
765411
765562

766132
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Description (9.2.2.0421)

Check for OS updates from the GUI is failing.

API reporting wrong FortiNAC version in its system/local-properties/cluster
GET.

VPN syslog messages not processed for FortiGates unless
VPNManagedNetworks attribute exists.

FNAC-M synchronize issue - NullPointerException.

ForwardingInterface debug:Enhanced API related output for FortiGate and
FortiSwitch integrations.

Added option to find host by serial number in PA server if unable to find by
MAC address.Addresses issue where MicroSoft InTune sometimes returns
randomized WiFi MAC Address (which are ignored by FortiNAC).

Duplicate Groups in FortiNAC causing SSO Tags to not be sent.
Proxy RADIUS to Cisco switch fails due to port lookup failure.
EMS server integration failing to correctly report compliance.

FortiNAC attempts to Deauth hosts that are not managed by FortiNAC from
Aruba Controller SSID.

Accounting Stop Message Discarded from Link Mode FortiSwitches.This
prevents hosts from being marked "offline" as expected.

FortiNAC-Manager Guided install doesnt change root/admin CLI
passwords.

Control Manager (NCM) Server List sometimes takes a long time to load.

Unable to resume control to Primary Server via Administration Ul in High
Availability configuration."Resume Control" button generates an error.

Device Profiler WinRM Method -> Credentials are required to be in
userPrincipalName format but shouldn't be.

Large network address scopes assigned for VPN managed addresses can
create memory and CPU utilization problems.

Routes no longer present after upgrade to 9.2.1 due to hsAddRoutes not
working properly.

Roles on Manager (NCM) cannot be changed.
Exception in CheckMacRunnable after initializing database.
Not able to change VLAN's on Cisco Meraki MS250-48FP.

Resynchronization of SSO sessions does not re-add any missing SSO
sessions.

RADIUS service is incorrectly enabled by default on new/unlicensed OVA
installs and Manager (NCM).
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Enhancements and Addressed Issues

766179 FortiNAC sends wrong keyword for SSO Dyanmic Address API.

766595 NoSuchProviderException in Radius Certificate initialization logic.

766858 Administration Ul not accessible after ResetToFactoryDefaults.

768711 Cannot import host record CSV due to serialization error.

764017 New DHCP fingerprint definitions forFortiFone and FortiCamera (Operating
System).

Version 9.2.1

Ticket # Description (9.2.1.0415)

666285 FGT interface with VLANSs does not show device connections to VLAN sub
interfaces

684953 Changed remaining "Topology" labels in Ul to "Network inventory"

736125 Netflow protocol support for device profiling.For details see Netflow Support
in the 9.2 Administration Guide

740229 Control Manager (NCM): Renaming scans and syncing creates duplicate
scans

741639 Parsing issue in reading Vlans and L3 data of DellSwitchOS10 models

741929 Control Manager (NCM) is throwing an IOException for Too many open files

742889 Virtualized Devices Ul/Tab should not show the internal dmgmt-vdom

744100 Unable to pull mac address information from Ruckus running V 5.2.Ruckus

requires REST queries to contain a serviceTicket

744313 SNMP errors for Mist APs in Event Logs

746629 Support for Aruba switch mac notification traps

746729 Support for Mobilelron cloud solution

746986 Separate app servers unable to update OS when using fnac-

updates.fortinet.net

747276 Mist APs created with incorrectly formatted MAC address, L2 polling
doesn't work

747324 When using port security on this switch, FortiNAC can no longer see any
MAC addresses connected and is unable to read anything

747378 Unable to register multiple hosts as a device from host view

747920 When runnning Device Discovery using SNMPv1/v2c Security Strings, v2c

is now used by default.If v2c fails, v1 is used

FortiNAC 9.2.5 Release Notes
Fortinet Inc.



Enhancements and Addressed Issues

747935

748041

748984

749565

749837

749885
750264

750287

750513
751092

751158

751181

751194

751204
751408

751472

751753
751780

751800

FortiNAC 9.2.5 Release Notes
Fortinet Inc.

Description (9.2.1.0415)

Local RADIUS - "Authentication Failure" event/alarm is triggered after
successful authentication

Default Portal Self-signed cert is owned by root, should be nac. Causes
deployment of new self-signed certs to fail

When a fingerprint is updated with new data, only the "Last Heard" time will
now be updated.The "Creation" time will remain the original value

FortiGate Version parsed incorrectly for security fabric dynamic address
integration.Any FortiGate with firmware greater than 7.0 but less than 7.0.2
will incorrectly appear as if it supports the new dynamic address
functionality

Potential ClassCastException syncing objects between Control Manager
(NCM) and pods

Null Pointer Exception when creating FortiGate model if API access fails

Network Inventory incorrect after moving FortiGate with managed AP's to
another container

Rebooting Ruckus SZ Controller causes SSID configurations to return to
use Inherited

SSO information is not sent in 3rd party SSO integrations

Endpoint Fingerprints > Set Source Rank > Modify without changes throws
an error

Rename existing RADIUS attribute group throws sql exception, can no
longer retrieve all groups

FortiNAC fails to login to CLI of Cisco SG/SF switches with the word "All" in
the banner

When adding a new Security Fabric Service Connector did not default to
port 8013 when it should

DPC Rule creation from fingerprints lack details

Local RADIUS should use VDOM for radius mode when SSID context
exists but is set to inherit config from device

RADIUS service will not start after upgrade to 9.2 if winbind is not
configured

Ports view blank for some FortiSwitches in Link mode.

Error dialog is displayed when registering an adapter as a device in
Topology

User host Profiles > add new User/Host profile > "Who/What by
Radius Request Attribute" is not being synced with Control Manager
(NCM)
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Enhancements and Addressed Issues

Ticket #

751853
752512
752785

752788
752838
752951
753414
753566

753597
753908
754256

755323
756126
756133

741938
753267

Version 9.2.0

Description (9.2.1.0415)

Database is not fully initialized on unlicensed start-ups
Unable to Assign VLANs on Ruckus Using Local RADIUS

Control Manager (NCM) Synchronization can produce Null Pointer
Exceptions in the logs

Alarm view fails to load due to Null Pointer Exception

Profiled Devices edit Rule Settings unable to be disabled

SNMP occasionally parsing MAC addresses incorrectly

Roaming Guest configuration left off of Aruba model configuration

Dropdowns in the VDOM Configuration view are bounded by the body of
the dialog

Hosts connected to Nokia switch (ISAM FX-4 7360) incorrectly show offline
Unable to import/export Device Profiling rules via Ul or REST interface

Null Pointer Exception in Devicelnterface when initializing SSO for
FortiGate and in BridgeManager when processing traps.

Assigning VLAN ID to Dead End Vlan fails with Ul error "Invalid ID - Dead
VLAN"

Unnecessary FortiGate related log messages printing by default.Moved
these messages to debug level logging

500 error in Policy Details appear when matching a policy using RADIUS
Attribute Filters in User/Host Profile

Policy Details in GUI shows wrong results.

Ticket # Description (9.2.0.0409)

518423 802.1x support for Aerohive SR2208P

522462 Trigger "System Created Uplink" Events for Learned and User created Uplinks

543215 Make change in mib to not use Native Vlan on Juniper EX switches

594554 VLAN Switch Success Event and Alarm to contain the "from" and "to" VLAN information

600122 Add a configurable delay after receiving a warm start/cold start trap before FortiNAC engages

with a switch

601831 Added support for Swagger Editor (used by FortiOS)

FortiNAC 9.2.5 Release Notes
Fortinet Inc.
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Enhancements and Addressed Issues

Description (9.2.0.0409)

611613

640641

650216
650626
659675

663957
665011
666660
671704

671997
672391

675847
676232
677981

682525
684657

685763

688265
689104
691837
691918
692461
692995

Topology > Set Model Configuration option does not apply selected "Send Groups to the
Firewall" and "Selected Groups" options for the FortiGate Virtual Device Model Configuration.

The dashboard is not showing any Mac agents. The total agents reflect the correct number but
the mac column is zero.

Unable to set firewall tags for PaloAlto model
FortiNAC System Date Format changed to YYYYMMDD_HHMMSS.

Provide Location (switch/AP and port), IP address, and "Connected Container" information into
the "Rogue Connected" and "Device Created" events.

Alcatel 6560 not switching VLANs
Added support to configure multiple Local RADIUS Servers
If a shared filter has an ! in it, a delete or edit silently fails

FortiGate VPN Host is incorrectly registered as a device with no "Registered To" information and
with "NAC-Default" Role

Juniper Flex-CLI not working due to configure mode prompt

Generate MAC Spoofing events when spoofing and spoofed machines are on the same switch.
For configuration instructions, refer to the Administration Guide.

VPN Model Configuration screen authentication method now displays LDAP checked by default.
Host with a disabled logged on user is not moved to dead end.

Improved multiple VDOM support for FortiGate VPN integrations. Previously, FortiNAC was
unable to determine correct tags to apply to sessions

Unable to register MS Intune endpoints that only have an ethernet adapter

Improved the communication method between Control Manager (NCM) and pods by using REST
API and certificate client authentication over HTTP Requirements: - Manager must be installed
with License key containing certificates (not required for pods). For more information see related
KB article FD52784 - Firewalls allow TCP port 8443 between Manager and pods If the above
requirements are not met, the Manager will use original communication methods

Changed Proxy Radius logic for VDOM lookup to use VDOM from attribute Fortinet-Vdom-Name
if present in auth request

Account Requests > Approve Request doesn't close the overlay on success
Send separate Emails for guest registration details and password

Add GUI functionality to enable or disable masquerading e-mail as other addresses
Improved Local RADIUS/winbind service operation visibility and debugging in GUI
Modifying group members not shown in admin auditing logs

Improved Dashboard view

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Description (9.2.0.0409)

693625
696239
696640
697296
698090
698728
699606

700276
700580
700580

700610
701378
701764
702259

702941
705017
705845
707166

707284

708635
708649
708651

708652
709269
709278
709293
709294

Groups service does not check for usage across different configurations
Port Channel Support for HP Switches

Access to gui is randomly lost

Add vendorCodes directory to System Backup

Fortigate L3 polls do not support reading IPv6 arp data

Telnet/SSH to a FortiGate fail when post-login-banner is enabled

A warning message now appears when attempting to install a legacy (NetworkSentry) license
key using the Ul

Add Contact Status Polling for Link Mode FortiSwitches.
Fortigate L3 Poller throws exceptions for static arp entries

When polling the Fortigate, if there are multiple ARP entries for the same MAC address, the
newest entry may not be used.

Kiosk Page is Not Loading
All API requests to a FortiGate fail when the post-login-banner is enabled
Portal - Self Reg Pending view not visible when instructions are set to be inline

Hostname information collected from FortiGate firewall sessions is no longer used for updating
rogue host records.The information was sometimes inaccurate

Query OUI,FortiGuard and NMAP for every new rogue
Settings > System Communication >Incorrect help text for Message Templates
Searching groups by name in Roles and Network Device Roles views doesnt work

When doing a quick search from Host View, if a host has multiple adapters that all match the
search query, each Dynamic Client is displayed independently

VLAN ID and VLAN Name drop-down menu contents are now sorted in the Model Configuration
View

WinRM/WMI PowerShell Command Restriction by McAfee EDR - EncodedCommand
Added Local RADIUS Server support for EAP-FAST. For details, see Administration Guide

Added support to authenticate Cisco Access Points using EAP-FAST and dynamically provision
network access.

New Device Profiling Method: ability to check certificate field to classify hosts & devices
FortiGuard Device Profiling method is not available on the Control Manager (NCM)

Secondary Server in High Availability responds to RADIUS after Primary Server resumes control
Added support to display FortiAnalyzer connection state

When using macOS browser to add FortiAnalyzer as a log receiver in the Administration Ul: -

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Description (9.2.0.0409)

709318

709447
709464

709559
709561

709661
709861
709965
710408
710576
710646

710971
711025
711377
711510
711696
712375
712591
712658
712678

712695
712887
712889
712980
713181
713259

Default port is now set to 514 - Ability to populate the Security string has been removed as it is no
longer used

SSH Known host keys can now be removed on-demand from the Credentials tab or automatically
whenever a device is removed

The text on the social login buttons sometimes spills over edge

Appliance installation is now done through the Administration Ul as opposed to a seperate
Configuration Wizard

Mist AP L2 Polling failure

Passive Agent Policy group pull down does not show any AD groups if one of the AD servers is
not reachable

Automated identification of potential L3 sources post device discovery

Added support for new APl introduced in FortiGate/FOS version 7.x

Server List panel in Control Manager Dashboard takes several minutes to build
Implement new FortiGate v7 FSSO REST API

Additional data needed for FortiNAC CTAP reports

Device Profiler Windows Profile method not working in HTTPS mode due to Command Line Too
Long error.

Update MacAddressTable command to get RADIUS working for Huawei switch
Removing an MDM service connector while there is poll in progress does not remove it
Support for tunneling REST API requests over CSF

PortLinkType not updated after resync interfaces

Failure to switch VLANs on Cisco SG200-50 switches

User/host profile does not match policy if Adapter information is used

Misleading password configuration pop-up box in High Availability configuration
Network Inventory takes a long time to load

Clicking on a user count in the user summary panel on the dash board does not create a Filter
when it opens Host View.

Administration Ul authentication fails when using a "+" sign in the password

Fixed issue that might cause Device Profiler custom rules to not match correctly

Only primary interface is imported to FortiNAC when host has multiple adapters

Fail to display interfaces on certain Extreme switch models due to unexpected port format
Added an import button to enable uploading hosts from an external file into the datatable.

Meraki Ports/Interface creation issue when the Group Policy name is assigned to Production

FortiNAC 9.2.5 Release Notes
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Enhancements and Addressed Issues

Description (9.2.0.0409)

713505
713591
713629

713870
713962
714399
714641

714692
714694

714702
714764
714768
714808
714947
714954
715251

715302
715316
715418
715678

716371

716411
716599
716603
716897

Logical Networks
Nokia switch port names do not contain switch name.
NEC QX Switches are discovered as generic SNMP devices.

System/Settings/System Communication/Email Settings -> Test Email settings works but
SendEmail tool doesnt

Failing to read arp cache on H3C
Added L3 support for Versa router
Exception during modeling leads to Cisco in locked state

Device |dentity view has been replaced with Endpoint Fingerprints view. Located under Users &
Hosts > Endpoint Fingerprints. See new features.

Removed iOS and Android from the "Add Device Profiling Rule" view.

New Fingerprint database to accommodate multiple fingerprint sources. Data is displayed via the
new Endpoint Fingerprints view.

Not reading L3 from all VDOMSs on a FortiGate.

New install>Need a way to upload a license key from the client file system
Fixed mapping for Alcatel-Lucent Enterprise OS6860E-P24

Ruckus L2 poll does not work with version 6

FOS group dynamic firewall address (FSSO) integration

Adding Virtual and Virtual Guest options to adapter Media Types

When RadiusManager debug is enabled and an unknown RADIUS attribute is received,
NullPointerException is printed and FortiNAC stops processing the request

Added the "screen" command to the repository and image
FSSO Race condition leaves some hosts with incorrect logon status
Fix debug in TrapHander to not mislead on linkup vs linkdown traps

Introduce USG SKUSs to restrict contact FortiGuard server, FDN Server and FortiNAC software
download server in US only

lllegalArgumentException thrown in PersistentAgent#isLinkLocal when called with an IPv6
address

FSSO tags are not sent when host role changes.
FortiNAC drops RADIUS packets at times of peak usage
Fix scripts to make them POSIX compliant

System>Settings>Trap Mib Files throws exception and does not function

FortiNAC 9.2.5 Release Notes

Fortinet Inc.

25



Enhancements and Addressed Issues

Description (9.2.0.0409)

717912
718168
718402
718783

718802
718831
719360
719780
720071
720129
720204
720360

720439
720467
720471

721204
721566
722811

723107

723563
723851
724173
724363
724383
724769
725009

Group Membership performance is too slow to handle load from policy engine
Add a convenience method to modify a local users password
Svglconlnterface isnt being loaded properly during build

FortiGate VPN failed to register for syslog and failed to login correct user if connection was lost
without notification.

Unable to collect host/user information from 6.4.3 EMS server.

InTune group add causes database issues

Unable to run install.bin if have legacy license key without High Availability
Catch All rule name inDevice Profiler is no longer modifiable

9.1 Online Help Generates 404 Error

Upgrade to 9.x fails with "Unsupported group policy type java.util. ArrayList"
Updated FortiNAC log schema for FortiAnalyzer

Added FirmwareVersion attribute on the Aerohive SR22XX/Unifi switch models for 802.1x
RADIUS CoA functionality

RadiusManager property included in "radiusManager.properties" file
FortiClient EMS integration should support the mac_list property in the API

Added cyber-blue MAC address 00:1A:7D:DA:71:15 to IgnoredAdapters.txt (Custom Ignored
Adapters List)

Added Mac Notification support for Dlink Switches
Custom Scans Registry-Keys view produces an error

In MDM integrations, fingerprints are now created with the hostName, OS or entity values for the
host instead of updating the host record directly.These are viewable in the new Endpoint
Fingerprint view

Add Fingerprint from Persistent Agent data.These are viewable in the new Endpoint Fingerprint
view

Event Alarm Mapping not adding %host% or %event% information to Email Action

DHCP Fingerprint for Mac OSX Bug Sur missing

Fix CoA on Fortigates with FortiLink switch, where secret is defined on the switch

Duplicate online hosts with same mac address are displayed under Adapters in Topology view.
FNAC sometimes failed to poll some clients connected to FGT/FSW FOS7.0.

Edit Role -> Groups -> Groups arent filtered

Imported LDAP group does not map to Administators
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Enhancements and Addressed Issues

Description (9.2.0.0409)

725360
725604

725629
725746

725751

725757
725972
725981
726024
726099
726329
726329
726410

726458

726678

726694

727066
727336

727710

727831

728160

728406

728409

Fix potential ClassCastException in MibObject

Host is auto approved by FortiNAC even when an approver is configured in Standard User Login
Portal.

Unable to properly manage Aruba 9012 WLC due to incorrect mapping

Communication issues between Control Manager (NCM) and POD causing Endpoint
Compliance failures

"Sync initiated" event added.Generated when a synchronization of servers by Control Manager
has been triggered.Provides server IP, the user who triggered the sync and status

Scheduler Modify dialog, Next Scheduled Time validator doesnt accept new time format
Remove unnecessary startup Relationinterface message from output.master

LEAP support has been removed from the Local RADIUS Server configuration

GA Renumber failed due to attempting to create + push existing tag

FSSO processing performance enhancements

Appliance installation is now done in the Administration Ul.There is no longer a separate Ul
Basic Network config wizard page control alignment is off, no need for multiple columns.

When a FortiLink Switch is renamed, the device and port model names in FortiNAC are not
updated.

DPC rule does not revalidate upon connect for RADIUS clients ("Confirm Device Rule on
Connect")

Added custom Network Devices Admin Profile permission set to view/hide the device model
Credentials tab

A Fingerprint is now created when FortiNAC updates a host record after reading the FortiGate
Firewall Session table.

Error dialog when setting device mapping to Generic SNMP using set device mapping option.

When collecting ARP information from ArubaOS WLC, the user table that contains the correct
ARP entries is not being queried

On upgrade from 8.8 to 9.1 or higher, the error
"com.mysql.jdbc.exceptions.jdbc4.MySQLSyntaxErrorException: Unknown table
'‘bsc.DatabaseAuditView™ may appear in the logs

Fingerprint attributes are not returned via REST get requests

MySQL Exception Incorrect integer value: 'GuestSelfRegistration' for column
'sendPasswordSeparately’ in output.master

Proxy RADIUS packet debug - attempts to convert non-human readable octet string attrs, clutters
output

Hosts and Adapters views only show 999 Entries.The REST APl is returning just the count of
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Enhancements and Addressed Issues

Description (9.2.0.0409)

728677

728719
728862

729007
729421
729585

729599
730236
730601

730789

730823
730857
730892
730908
730990
731215
731580
731597
731633
732229
732265
732340
732580
732614
732965

records in the current page

Local RADIUS Server fails to disconnect clients from Ruckus Virtual SmartZone (SZ) controller
due to missing RADIUS attributes

Add Device Profile Rule > Vendor OUI > Clicking Vendor OUI link results in HTTP 500 Error

Enhanced Devicelmport CLI tool including SNMPv3 support. For details on all options, type
"Devicelmport" in the CLI

NullPointerException during V3 device creation via APl when no v1 community strings provided
Enhanced device type classifications based upon OUI

Cisco ASA VPN clients not moved to the unrestricted group due to multiple values returned when
reading object-group

Obtrusive error popup thrown upon navigation to Topology view
Failure to read SSID on Ubiquiti causes all SSID models to be removed

Changing Endpoint Complaince scan causes agents to be rescanned even when monitors were
not changed

When wired clients are authenticated by the Local RADIUS Server, the default VLAN is returned.
Network Access Policy look-up is skipped

Multiple calls to edit a User Host Profile via the API results in failure after the first attempt
No error message when DHCP scopes fail to import from file

VPN solution L2 polling process excessively long

Errors with secrets with special characters like %

Ul rendering for Authentication Policies/Configs tied to wrong permissions

Added support to read L3 tables on Dell 0S10 switches with VRFs configured
Exception is displayed in server log during initialization

Exception is logged when no devices present

SQL Exception is thrown during FortiNAC server startup

Missing event and alarm definitions for ADMIN_PROFILE_MODIFICATION

Aruba Controller model configuration view is not showing supported RADIUS controls
dumpports does not show port IP address (requestString)

Added "sar" output in grab-log-snapshot

Clicking Read VLANs on Model Configuration view fails due to not-a-function error

Local RADIUS Server functionality not working properly upon failover or recovery in High
Availability configuration
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Enhancements and Addressed Issues

Description (9.2.0.0409)

733232
733903

733969

734792
734895
735444
735553
735791
736110
736125
736465

736501
736553

736796
737244
737732

737740
737779
738093
738096
738257

738375
738388

738721
738805
739112

Unable to save private filters

Setting Host Expiration field to "Never" resulted in inaccurate expiration dates (example
12/31/1969)

Unable to poll Airwatch MDM hosts. Although MDM poll appears to complete, new registered
hosts are not created

AP| communication issues with FortiGate

Unable to parse L2 table on Dell OS10 Switches

All RuggedCom switch models are shown as RSG2300 in the model configuration views
CLI and Vlan switching not functioning for Allied and Rugged devices

Secondary servers do not retain contract entitlements

Excessive exceptions for DatabaseObjectAlreadyExistsException seen in logs

Added Netflow protocol support for Device Profiling

MAC address label is hidden if the IP address field is disabled in the Game Register portal
configuration

Cisco ASA VPN users are not always unrestricted after connecting

Log format has changed to include the thread ID and to remove redundant timestamp in
heartbeat messages

Added L3 Device Identification Ul.
Add REST API call to confirm device profiling rule in DeviceldentityService

FortiGate FSSO functionality is now configurable using address scopes and address groups for
more flexible configuration

Added PolicyHelper debug control / visibility to RADIUS log Ul for improved troubleshooting
Added ability to configure CLI Passwords using the Administration Ul

ISO build missing bc package

Add checkboxes to support proactive nmap and Fortiguard method profiling

Improved user look-up method to handle the different userID formats when matching Network
Access Policies based on user record criteria. Previously, this was seen to cause delays in
responding to RADIUS Accepts in some environments

RADIUS processing performance issues when RadiusManager debug is enabled

Debug was added to indicate when System > Settings > Updates > System protocol is set to
SFTP.This protocol has been deprecated

Device Identity view has been removed
Unable to set SSH port on Device Credentials page in version 9.1.2

Improved default level log output to include more informative messages
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Enhancements and Addressed Issues

Description (9.2.0.0409)

739131
739465
739674
740034
740723

740749
741811
741864
741929
741952
741954
741994

742260
742261
742347
742861
743381
743535
743543
744025
744100

744371
745083
745133

709030
710957

716411
715316

717912

Need to replace mysql-connector

Removed Local RADIUS requirement that request must contain Service-Type=10(Call-check)
Local RADIUS MAB & CHAP fixes

Exception in RadiusManager with logging enabled

Devices with VDOMs that specify local radius server/secret and use the mgmt IP - on restart the
nas DB tbl entry is removed

Local RADIUS can only handle secrets of 60 characters or less

Update of Adapter IPs causes empty replaces of DYNAMIC table

Switching port vlans fails for Rugged devices

Control Manager (NCM) is throwing an IOException for Too many open files
No response in Ul when adding new network devices

Add ability to read ethernet adapter for Google GSuite devices

SSIDs added to groups with wrong type when added via SSID -> Group Membership preventing
policy engine match on the group

NullPointerException in DeviceServer.getVoiceVlans()

NullPointerException in ProbeTelnet.getProbeObjectsBylnetAddress()
IndexOutOfBoundsException in BridgeManager.VianVerifyVector.put()

More granular OS information collected from agents.Displayed in Agent Fingerprints
Missing description for Radius in System/settings/Authentication/Radius

License for jersey packages is listed incorrectly as EPLv2/GPLv2 in Help > Legal view
Caching of dot1qIDtoVIDMappings not working on Juniper switches

Location based Device profiling rule does not work consistently

Unable to pull mac address information from Ruckus running V 5.2.Ruckus requires REST
queries to contain a serviceTicket

Fixes potential performance issue in table views.
Control Manager (NCM) Sync fails with ArraylndexOutOfBoundsException
SSH is intermittently failing to some Cisco devices

Improved the speed of Device Discovery

FortiGate VPN hosts marked At Risk do not trigger a network change.FSSO device
synchronization doesn't work properly with VDOMs.

Group Membership performance is too slow to handle load from policy engine
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Enhancements and Addressed Issues

Ticket# Description (9.2.0.0409)

715316

733892
733914

733903

735520
729033
731645
731193
728989

739380
745058

742929

LicenseTool APPLIANCE shows EFFECTIVE count/level/certs if both are requested

Setting Host Expiration field to "Never" resulted in inaccurate expiration dates (example
12/31/1969)

Agent 5.3.0 package included

AirWatch does not retrieve all MAC addresses for enrolled devices

The number of Operating System and Anti-Virus program options in the Scan Configuration have
been reduced. Only those currently supported or commonly in use are now listed. Systems
initially installed with 9.2.0 will have this change applied by default. Upgrades will have this
functionality enabled upon the first auto-definition sync.

For a list of available Operating Systems and Anti-Virus programs, see KB article FD53449.

https://kb.fortinet.com/kb/microsites/search.do?cmd=displayKC&docType=kc&externalld=FD53
449
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niKnown Issues Version 9.2.5

nikKnown Issues Version 9.2.5

Ticket# Description (9.2.5.0443)

874037 GUI > Users & Hosts > Host View > Quick Search - Unable to locate host by hyphen or no
delimiter.

882265 FortiNAC is not sending the correct serial number field to FAZ.

780312 FortiNAC does not integrate with Azure Active Directory due to SAML connection requirements.
754346 Default filter used when selecting Port Changes for a specific device port does not work.
874812 Private VLAN switching is not working > Cisco switches.

878059 Using Location that specifies a device will not work if that device is a FortiLinked FortiSwitch
641036 Multi-factor authentication (MFA) for the Administration GUI login is currently not supported.
877942 Performance issues related to Firewall Session table growing to large

686910 Control Manager (NCM) communication issues when the NAC systems are connected through

714219 the WAN. For details see related KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Note-NCM-communication-issues-with-
systems-across-WAN/ta-p/192434.

792968 Legacy View for Users & Hosts > Hostsdoes not display items in tables. Workaround: Enter “*”
(asterisk) in search field.

752538 When in the Users & Hosts > Applications view, selecting an application and clicking the Show
Hosts option displays a page that does not provide accurately filtered results. Workaround:
Navigate Users & Hosts > Hosts and create a custom filter to list hosts associated to an
application.

766850 Landing page defined by an Admin profile is not honored. User with that Admin Profile is
presented with the FortiNAC Dashboard instead. Workaround: Manually browse to intended
landing page.

770091 Port changes/VLAN assignments made using Local RADIUS are not being logged as port
changes.

760926 Removal/Addition of LDAP model can cause user attribute synchronization issues. For details
and workaround see KB article https://community.fortinet.com/t5/FortiNAC/Technical-Tip-
Removal-Addition-of-LDAP-model-can-cause-user/ta-p/209296.

754346 Selecting Port Changes under the Ports tab of a specific device inNetwork > Inventorydoes not
display expected results. For details and workaround, see KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Tip-Default-filter-for-Port-Changes-does-
not-populate/ta-p/209297.

791442 Able to delete a Portal Configuration which is in use by a Portal Policy. Removal is done without
warning the user.

710416 There can be a delay in updating IP addresses for isolated hosts in host and adapter view.
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Ticket# Description (9.2.5.0443)

708936 FortiNAC will logoff SSO for sessions that remain connected to a managed FortiGate IPSec VPN
tunnel after 12 hours.

708720 Policy evaluation may not be triggered after a host status update in Microsoft InTune. This can
prevent the host from being moved to the proper network. For details and workaround see
related KB articlehttps://community.fortinet.com/t5/FortiNAC/Technical-Tip-Policy-evaluation-
not-triggered-after-Microsoft/ta-p/203843.

694407 Linux hosts running CrowdStrike Falcon sensor 6.11 and later are not being detected by the
agent. This causes hosts running CrowdStrike Falcon to incorrectly fail scans. For details and
workaround, see related KB article https://community.fortinet.com/t5/FortiNAC/Troubleshooting-
Tip-Linux-hosts-running-CrowdStrike-Falcon/ta-p/202694.

682438 Page Unresponsive' error when exporting hosts.For details and workaround see related KB
article https://community.fortinet.com/t5/FortiNAC/Technical-Note-Page-Unresponsive-error-
when-exporting-hosts/ta-p/193878.

677628 Cisco WLC Port Channel not classified as Learned Uplink.For details and workaround see
related KB article https://community.fortinet.com/t5/FortiNAC/Technical-Note-Cisco-WLC-Port-
Channel-not-classified-as-Learned/ta-p/196208.

675180 False positive Scan Results when there are no sub-settings selected in Operating System
check.

674438 "Processes" Scan Type option is not available when creating custom scans for macOS systems.

646580 Restarting FortiNAC services can generate a large number of SSH sessions with ASA.For
details, refer to related KB article https://community.fortinet.com/t5/FortiNAC/Technical-Note-
Restarting-services-can-generate-large-number-of/ta-p/195876.

631115 Only 50000 records display in Adapter and Host Views.Example:Adapters - Displayed:
50000Total: 57500

610581 L3 eth1 sub-interfaces are not removed after re-configuring an appliance configured for L3
Network Type to L2.

609976 Cisco WLC 9800 Model Configuration tab does not include the drop down VLAN lists under
Access Value. For details and workaround see related KB article
https://community.fortinet.com/t5/FortiNAC/Technical-Note-Cisco-WLC-9800-Model-
Configuration-tab-does-not/ta-p/198790.

609046 A port where the master Aruba Instant AP (IAP) with VIP is connected becomes a “learned
uplink”. This type of uplink is not dynamically undone / removed when the IAP (with the VIP) is
disconnected from that port.

522468 Although there are fields to set the role or access value in the Authentication portal, these
functions are currently not supported.

762704 After clicking the 'restart services' button when applying SSL certificates to the Admin Ul
Certificate Target, the prompt does not clear and there is no confirmation dialogue (even though
it was successful). Clicking the 'restart services' button again generates an error.

795932 FortiNAC does not track the currently active LDAP server. This can cause Local RADIUS
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Ticket# Description (9.2.5.0443)

authentication to fail when the primary LDAP server is unreachable.

808088 Alarms stop generating notifications. Affects environments with notifications configured for high
frequency alarms.

812908 /var/log/messages not rotating. This generates large files and causes high disk utilization issues.
813652 Security Alarms are not generating from Security Events.

811479 Upon failover or resuming control in a High Availability environment, the Local RADIUS service
does not start on the appliance in control. Workaround:On appliance in control, either manually
start the radiusd service or reboot.

817845 L2 polling can become backlogged in environments where there are a number of hosts with
Registered to userid of "NULL".

761745 Mist AP - Port Connection State NOT WAP Uplink.
773088 No VLAN Information for Adtran NetVanta 1638.

774048 L2 HA + VIP Pairing Process Failing.Configuration completes but leaves both appliances in a
"processes down" state.Workaround: Reboot appliances.

775679 Host records manually disabled via their user record are re-enabled after a directory sync.

784543 403 error is displayed when sending an email from Guests and Contractors view.Affects
FortiNAC admins with limited permissions.Workaround:Enable portal policy permissions in the
admin profile.

806106 Juniper Change of Authorization (CoA) fails.

811404 Admin Ul showing error "You do not have permission to access this page". Workaround: Restart
807309 tomcat-admin service.

810209 Not all SSIDs are read from Aruba controllers.
812674 CoAis not being sent to Huawei wireless after host has registered.

812581 "Duplicate user id" messages in master logs during RADIUS authentication when userID does
not match the name in the email address associated with the user record.Affects Local RADIUS
implementations.

813564 FortiNAC fails to find API port from standalone Mode FSW running 7.2.
814631 %port% variable is reading port id rather than port number.Affects FlexCLI configurations.

815352 Logical network configuration mappings can return the wrong value when host is connected via
more than one interface.

816871 Secondary server fails to complete OS updates in High Availability environment.

817040 FortiNAC Manager fails to connect to pods configured for L2 High Availabilty with a virtual
IP.Manager is querying ethO IP instead of Virtual IP.

818504 Linux Persistent Agent fails to install using the .deb package.
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Ticket# Description (9.2.5.0443)

767548 Register Game system with Host Inventory success page is not working.
776077 Local Radius to Winbind connection cannot be secured at this time.

783304 DHCP responds with unexpected addresses in the DHCP-Server-ldentifier attribute. This causes
release/renew to fail.Affects appliances configured for seperate isolation networks (Registration,
Remediation, DeadEnd, etc).

793634 MDM Server Last Polled and Last Successful Poll information removed in 9.x.
800255 Device Profiling IP Range Method does not include .255 when using wildcards.

806936 Importing Mist devices using the CLI deviceimport tool does not add the AP's to the proper
groups.

810574 "Unable to scan" message when using Dissolvable agent if scan configuration label contains non
US-ASCII characters.

811783 Links in the Persistent Agent Summary panel produce redundant results.
814183 Unable to view all Certificate Details in the Certificate Management view.

816451 When importing DHCP Scopes with spaces in the names, the Configuration Wizard Summary
displays blank scope data.

816877 Profiled device icon does not match the icon assigned by Device Profiling Rule.
710583 L2 Polling Mist APs can result in more API requests than Mist allows per hour.
817022 FortiNAC does not update Rogue record's Host Name from DHCP fingerprints.
765172 Configuration Wizard does not check whether user input subnet masks are valid.
820160 Roles view is not available with a Base License.

821244 Hosts fail to match Device Profiling rule configured with the FortiGuard Method because the
confidence score is negative.

824088 Unable to update existing Registered Host records using Legacy View > Hosts > Import.

825436 IP addresses appended to network device names during discovery are truncated resulting in
duplicate device and port names.

825920 Radius CoA fails when the radius request source ip address is the Access Point rather than the
Ruckus SZ Controller.

791751 Host Import - importing same file twice results in "null" error and exception in logs.
828912 MaaS360 MDM poll fails.

828242 Layer 3 polling Ruckus ICX7450 switches running 8.0.95g and later may result in fewer arp
entries than expected.

828128 Unable to add Allowed Domains containing underscore symbols.

827870 When a FortiGate device model's IP address is changed in the Inventory view, add/delete/move
syslog messages from the new IP address is discarded until FortiNAC services are restarted.
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Ticket# Description (9.2.5.0443)

827283 Roaming Guest Logical Network missing from FortiGate Model Configuration.
826913 Creating a Network Device Role using Direct Configurations reverts to Logical Networks.
826155 24-bit OUls are not added to the Vendor OUlIs list for IEEE MA-M and MA-S blocks.

829702 FortiGate wireless clients cannot connect after a FortiNAC software upgrade if the FortiGate
device model's RADIUS secret is not populated.This is true even though the VDOM radius
secret is populated.

829019 Manager's (NCM) Resume Control button on the Dashboard in a High Availability environment
does not restore control to the primary Manager.

Not all models of all network devices can be configured to perform Physical MAC Address
Filtering even though the Admin Ul indicates that the configuration can be set.Resolution: Hosts
can be disabled by implementing a Dead-end VLAN.

For Portal v2 configurations, web pages that are stored in the site directory to be used for Scan
Configurations will not be included when you do an Export of the Portal v2
configuration.Resolution: The files in the site directory are backed up with the Remote Backup
feature, but otherwise keep a copy of these files in a safe place.

Removing a device from the L2 Wired Devices or L2 Wireless Devices Group does not disable
L2 (Hosts) Polling under the Polling tab in Topology.

The "Set all hosts 'Risk State' to 'Safe™ button changes the status of all hosts marked At-Risk to
Safe.However, the status of the individual scans for each host remain unchanged.

In a Layer 3 High Availability (HA) environment, configWizard must have a DHCP scope
defined.Running configWizard without a DHCP scope can cause a failover.

On FortiNAC appliances with CentOS 7, duplicate log messages may appear in dhcpd.log for
each sub interface (eth1, eth1:1, eth1:2, etc).

System > Settings > Updates > Operating Systemwill only record and display dates of OS
updates that are completed through the Administrative Ul. If Operating System updates are run
via command line using the "yum" tool, the update is not recorded. Resolution: Execute
Operating System Updates through the Administrative Ul in order to maintain update history.

Only English versions of AV/AS and their corresponding definitions are supported.
Anti-Virus product lolo technologies System Mechanic Professional is currently not supported.

FortiEDR is currently not supported.If required, contact sales or open a support ticket to submit a
New Feature Request (NFR).

Sophos UTM is currently not supported.
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Device Support Considerations

Ticket # Description

730221 Stacked Meraki switches currently not supported. If required, contact sales
or support to submit a New Feature Request (NFR).

548902 Management of wired ports on Aerohive AP-150W controlled by
AerohiveNG is currently unsupported.

606729 The feature "Palo Alto VPN Integration" is currently not supported. It has
been determined not to be ready for customer production use for managing
remote user VPN connections through Palo Alto firewall.

679230 Aruba 9012-US currently not supported. If required, contact sales or
support to submit a New Feature Request (NFR).

829009 The Allowed VLAN list is not properly managed on Aruba CX switches.
When FortiNAC performs a VLAN change, only the new VLAN is set. The
previously configured Allowed VLAN is not removed. This causes the
Allowed VLAN:S list to grow over time.

836831 Layer 2 polling HPE Walljacks fails if special characters are found in the
devices mac-address table.

842181 FortiNAC does not support the custom RADIUS attribute Fortinet-Host-
Port-AVPair action=bounce-port for Change of Authorization (CoA) with
FortiSwitches.

843509 FortiNAC is unable to communicate with Dell x1026 switches.

846782 FortiNAC is unable to read roles and potentially other data from Aruba IAPs
due to a # symbol automatically added to the wireless network name.

7680531 Ubiquiti Gen2 Unifi switches (example: USW-16-POE) are currently not
supported. If required, contact sales or support to submit a New Feature
Request (NFR).

860546 L3 Polling currently not supported on Extreme Wireless Controllers

At this time, integration with Juniper MAG6610 VPN Gateway is not
supported. This includes Pulse Connect Secure ASA.

At this time, integration with Cisco 1852i Controller is not supported due to
the device's limited CLI and SNMP capability. For details, see related KB
article 189545.

At this time, Fortinet does not support wired port management for the Cisco
702W. The access point does not provide the management capabilities
required.

At this time, Fortinet is not able to support the Linksys LAPN600 Wireless-
N600 Dual Band Access Point.
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Ticket # Description

Ports on Avaya Networks 4850GTS-PWR+ switches sometimes show "Not
Connected" even though the port is active. This is due to multiple ports on
the switch using the same MAC Address. This prevents NAC from correctly
discerning which are "Connected" versus "Not Connected". There is no
workaround.

Device models for Avaya 4800 switches (and potentially other related
models) only support SSH. Device models for Avaya Ethernet Routing
Switches only support Telnet. Contact Support if the alternate protocol is
required.
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Device Support

These changes have been made in FortiNAC Version 9.2. These are in addition to the device support added in
previous releases.

Version 9.2.5

765569 DIGI cellular routers

789282 Extreme Campus Controller WLC

790006 Netgear S4300 and S3300 Switches

801676 HPE Comware Platform Software, Software Version 7.1.070, Release 6327

SG350XG-24F 24-Port 10G SFP+ Stackable Managed Switch
SG300-28SFP 28-Port Gigabit Managed SFP Switch
Linux PA-Mac-Ops-BCKPF-S 4.14.76-release-1.3.0 1 SMP

Aruba JL725A 6200F 24G CL4 4SFP+370W Swch ML.10.09.1000
Cisco 10S Software [Cupertino], ISR Software (ARMV8EL_LINUX_10SD-
UNIVERSALK9-M), Version 17.7.1a

Cisco Sx220 Series Switch Software, Version 1.1.3.1

CBS350-24P-4G 24-Port Gigabit PoE Managed Switch
Firewall OCI Unimedsc

Palo Alto Networks VM-Series firewall
Canton-Firewall

806646 S5735-L24T4X-A1 Huawei Versatile Routing Platform Software VRP (R)
FGT85F

S5731-H24T4XC Huawei Versatile Routing Platform Software
FGTVM641000C

S5732-H48UM2CC Huawei Versatile Routing Platform Software
FGT50A

JL581A Aruba 8320 48p

Juniper Networks, Inc. ex3400-48t Ethernet Switch
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Version 9.2.4

Ticket # Vendor (9.2.4.0438)

796633 Fortigate

Cisco I0S Software, C1000 Software (C1000-UNIVERSALK9-M), Version
15.2(7)E4

Aruba R8N87A 6000 24G CL4 4SFP Swch PL.10.08.1010
Meraki MS355-48X2 Cloud Managed Switch

Dell EMC Networking OS10 Enterprise.S5224F-ON

Version 9.2.3

Ticket # Vendor (9.2.3.0435)
765568 Huawei AR550E router/switch
769085 MICROSENS G6 Micro-Switch
S5731-H48T4XC
FW_WLC
770214 S5300-52C-PWR-EI

S5731-S48P4X

Alcatel-Lucent Enterprise OS6465T-P12
Alcatel-Lucent Enterprise 0S6465-P12
FG_GRP9

brayhall-core-router

Meraki MR20 Cloud Managed AP

771979 SG250-08 8-Port Gigabit Smart Switch
S5700-10P-LI-AC
DC FortiGate Cluster

774429 Cisco NX-OS(tm) nxos.7.0.3.14.1.bin, Software (nxos), Version 7.0(3)I4(1)
Dell Networking X1018P 1Gb PoE Switch
SG350-28 28-Port Gigabit Managed Switch
Ruijie 10G Ethernet Switch with PoE (S2910C-48GT2XS-HP-E)

777886 D-Link DGS-3130-30TS System - 24*10/100/1000M + 2*10GBase-T +
4*10G SFP+, 145.1.10.57
Fortigate
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Ticket # Vendor (9.2.3.0435)

Cisco I0S Software, CDB Software (CDB-UNIVERSALK9-M)
Quidway S7706 Huawei Versatile Routing Platform Software

Cisco I0S Software, C880 Software (C880VOICE-UNIVERSALK9-M)
Fortinet

Cisco 10S Software, ir800 Software (ir800-UNIVERSALK9-M)

781634 S5700-52P-LI-AC Huawei Versatile Routing Platform

783982 S§5720-12TP-LI-AC
S$5720-36PC-EI-AC
S§5720S-52P-SI-AC
S$5700-10P-PWR-LI-AC

786422 ArubaOS (MODEL: 565)

787686 S5735-L48T4S-A1 Huawei Versatile Routing Platform Software VRP (R)
software
CBS350-48P-4X 48-Port Gigabit PoE Stackable Managed Switch with 10G
Uplinks

CBS350-48P-4G 48-Port Gigabit PoOE Managed Switch

CBS350-8P-E-2G 8-Port Gigabit PoE Managed Switch

CBS350-24T-4X 24-Port Gigabit Stackable Managed Switch with 10G
Uplinks

Linux Lethe 2.6.18-92cpx86_64 1 SMP Mon Oct 8 10:34:42 IDT 2018 x86_
64

Juniper Networks, Inc. srx380-poe-ac internet router, kernel JUNOS
20.4R3-S1.3

S5735-L8P4S-A1 Huawei Versatile Routing Platform Software VRP (R)
software

Fortigate fwf51E

Quidway S9712 Huawei Versatile Routing Platform Software VRP (R)
Software

Brocade Communications Systems, Inc. Fastlron SX 1600
CCB 1st Sessions Court FS108F
Meraki MR36H Cloud Managed AP

792686 Huawei AR129CGVW-L Huawei Versatile Routing Platform Software VRP
(R) software

Cisco NX-OS(tm) nxos.9.3.7.bin, Software (nxos)

Juniper Networks, Inc. ex4400-24p Ethernet Switch, kernel JUNOS
21.1R1.11

Aruba R8N85A 6000 48G CL4 4SFP Swch PL.10.09.1000

Aruba Instant On 1930 8G 2SFP Switch JL680A, InstantOn_1930_1.0.5.0
(139)

IE1000 Industrial Ethernet Switch, Version: 1.7.0#2018-05-
02T18:19:37+00:00
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Version 9.2.2

Ticket # Vendor (9.2.2.0421)

760460 FortiSwitch
Dell EMC Networking N1124T-ON
Alcatel-Lucent Enterprise 0S6560-P24X4
Alcatel-Lucent 0S6450-U24
ExtremeXOS (X620-16x)
ExtremeXOS (X450G2-24p-10G4)
Aruba ROM68A 2930M-24SR-PoE-Class6 Switch
Aruba JL727A 6200F 48G CL4 4SFP+370W Switch
Aruba JL675A 6100 48G CL4 4SFP+
PLANET, IGS-10020HPT, IE L2+ Managed Switch

761980 Alcatel-Lucent Enterprise OS6860E-P48
Alcatel-Lucent Enterprise OS6560-24X4
Alcatel-Lucent Enterprise 0S6560-P48Z16
Alcatel-Lucent Enterprise OS6560-P48X4
CHS_Fortigate_ VM04

763316 VSP-4900-12MXU-12XE

765550 Alcatel-Lucent Enterprise OS6560-48X4
Enterasys Networks, Inc. A4H124-24
24-port 10/100 PoE Switch w/4 gigabit ports S5735-L48P4X-A1
Huawei Versatile Routing Platform
Huawei AR550E Huawei Versatile Routing Platform

766493 Dell PowerConnect 5548P

767310 HP 1910-24 Switch
Allied Telesis router/switch, AW+ v5.4.6-1.5

Version 9.2.1

Ticket # Description (9.2.1.0415)
749162 FortiSwitch-108F-POE
752957 Aruba Instant On 1930 48G 4SFP/SFP+ Switch JL685A

HPE 5510 24G PoE+ 4SFP+ HI 1-slot Switch
JH147A WS6-DGS-1210-28/F1 6.10.007
Dell Networking N1524
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Ticket # Description (9.2.1.0415)

Palo Alto Networks PA-3200 series firewall
HP 1820-48G-PoE+ (370W) Switch J9984A
Hirschmann MICE Switch Power
Hirschmann Rail Switch Power Enhanced
USIDC-FWL001

swich standalone

NetVanta 1534P

AOS-W (MODEL: OAW-4030)

756556 Enterasys Networks, Inc. Bonded SSA Chassis Rev 08.11.04.0005
754988 FSW_248E_POE
FSW_148F

FSW_148F_POE
FSW_148F_FPOE
FSW_124F
FSW_108F
FSW_108F_POE
FSW_108F_FPOE
FSW_1024E
FSW_T1024E
FSW_124F_POE
FSW_124F_FPOE

Version 9.2.0

Ticket # Vendor (9.2.0.0409)

688048 ApresiaNP2000-24T4X
ApresiaNP2000-24T4X-PoE
ApresiaNP2000-48T4X
ApresiaNP2000-48T4X-PoE
Apresia13200-28GT
Apresia13200-52GT
Apresia5428GT
Apresia3424GT-SS
ApresialLightGM110GT-PoE
ApresiaLightGM110GT-SS
ApresialLightGM118GT-SS
ApresiaLightGM124GT-PoE
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Ticket # Vendor (9.2.0.0409)

ApresiaLightGM124GT-SS

ApresiaLightGM152GT
706225 Ruijie XS-S1960
712593 Huawei S2700-9TP-PWR-EI

Meraki MS125-48FP Cloud Managed PoE Switch
Huawei S5735-S48T4X

Extreme Networks, Inc. A2H124-24P

Cisco Controller

ArubaOS W-AP103
714422 Planet IGS-10020PT
720989 Cisco 10S Software, C1000 Software (C1000-UNIVERSALK9-M), Version
15.2(7)E2

Huawei S5735-L24P4S-A

Huawei S5735-L48P4X-A

SG350-28SFP 28-Port Gigabit SFP Managed Switch

ExtremeXOS X440G2-24x-10G4

ExtremeXOS X440-24x-10G

ExtremeXOS X440-L2-24t

ExtremeXOS X440-24x

ExtremeXOS X620-8t-2x

Industrial 6-P GbE RJ45 + 2-P GbE SFP L2 Plus Managed UPoE Switch
Dell EMC Networking N3132PX-ON

Dell EMC Networking S3148P

Dell EMC Networking OS10 Enterprise

Dell Networking OS Series: PE-FN-410S-IOM

Dell EMC Networking OS10 Enterprise

Aruba JL660A 6300M 24SR5 CL6 PoE 4SFP56

Meraki MS390-24UX L3 Stck Cld-Mngd 24-port mGbE UPoOE switch
Meraki MS390-48UX2 L3 Stck Cld-Mngd 48-port 5GbE UPoE switch
Fortinet FortiGate

Ruckus Wireless, Inc. ICX7150-24-POE, SPR08090b

50-Port Gigabit PoE Smart Switch

Viptela SNMP agent
721009 Added missing property for Viptela devices
724820 Ruckus Wireless, Inc. ICX7850-48FS

Dell EMC Networking OS10 Enterprise, System Type: S5212F-ON
Ruckus Wireless, Inc. ICX7650-48F
HVC-Budel-FWO01
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Ticket # Vendor (9.2.0.0409)

Brocade Communications Systems, Inc. ICX7250-24, labeled as
SPS08030

Brocade Communications Systems, Inc. FWS648G-POE, labeled as
FWSL07400d 1

Ruckus Wireless, Inc. ICX7150-C08-POE, labeled as SPS08091
Dell Networking OS, Series: MXL-10/40GbE
Cisco |0S Software, C2960CX

730834 Foundry Networks FWSX424+2XG
Ruckus Wireless, Inc. Stacking System ICX7550-24F
Huawei S5720-52X-LI-AC
HP Series Router A-MSR30-10
H3C Series Router MSR30-10
Alcatel-Lucent Enterprise 0S6350-P24
Alcatel-Lucent Enterprise 0S6350-48
LGS308P 8-Port Gigabit POE+ Smart Switch
HPE MSR3012
Meraki MR44 Cloud Managed AP
Dell S4112T-ON
Aruba JL676A 6100 48G 4SFP+
Aruba JL679A 6100 12G CL4 2SFP+
Dell S5048F-ON
Brocade ICX7150-48-POE
Brocade ICX7150-48-POEF
HPE OfficeConnect 1950-24G-2SFP+-2XGT
Huawei S5735-S48P4X Cisco NX-OS(tm) n5000

734133 Pnetworks switch

735445 Huawei Quidway S3352P-El
Huawei Quidway S9306

743833 Cisco Nexus(Cisco NX-OS(tm) nxos.9.3.5.bin)
Cisco Nexus (Cisco NX-OS(tm) nxo0s.7.0.3.17.9.bin)

745113 Dell EMC Networking OS
S5730-68C-PWR-SI-AC Huawei Versatile Routing Platform Software VRP
S5730-48C-PWR-SI-ACHuawei Versatile Routing Platform Software VRP
SX350X-52 52-Port 10GBase-T Stackable Managed Switch
PLANET IGSW-24040T Managed Switch

Cisco I0S Software, CSR1000V Software (X86_64_ LINUX_IOSD-
UNIVERSALK9-M)

Cisco 10S Software, C3560E Software (C3560E-UNIVERSALK9-M)
Dell EMC Networking N2224PX-ON, 6.6.1.1, Linux 4.4.170-b055baf1
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Ticket # Vendor (9.2.0.0409)

Dell EMC Networking N3024EF-ON, 6.6.3.36, Linux 4.14.138, v1.0.5
Dell EMC Networking N2248PX-ON, 6.6.3.10, Linux 4.15.18-2ac8b3ec
Dell EMC Networking N3248P-ON, 6.6.3.14, Linux 4.15.18-2ac8b3ec
Dell EMC Networking N1108EP-ON, 6.6.3.10, Linux 4.14.138
FortiGate

Aruba JL677A 6100 24G CL4 4SFP+ Swch PL.10.06.0001

Juniper Networks, Inc. ex3400-24t Ethernet Switch

HPE 1950 48G 2SFP+ 2XGT Switch

Meraki MR53E Cloud Managed AP

Linux cep-gate 3.10.0-957.21.3cpx86_64 1 SMP

Aruba JL659A 6300M 48SR5 CL6 PoE 4SFP56 Swch FL.10.08.0001

689049 Dell Switch S4128T (DellSwitchOS10)
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System Update Settings

System Update Settings

Use the following System Update Settings when upgrading through the Administrative Ul:

Field Definition

Host Set to fnac-updates.fortinet.net

Auto-Definition Directory Keep the current value.

Product Distribution Systems running version 8.3.x and higher: Set to Version_9_2
Directory

Agent Distribution Keep the current value.

Directory

User Set to updates (in lowercase)

Password Keep the current value.

Protocol Set to desired protocol (FTP, PFTP, HTTP, HTTPS)

Note: SFTP has been deprecated and connections will fail using this option.
SFTP will be removed from the drop down menu in a later release.
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Numbering Conventions

Fortinet is using the following version number format:

<First Number>.<Second Number>.<Third Number>.<Fourth Number>

Example: 8.0.6.15

First Number = major version
Second Number = minor version
Third Number = maintenance version
Fourth Number = build version

Release Notes pertain to a certain version of the product. Release Notes are revised as needed. The Rev
letter increments accordingly. For example, updating the Release Notes from Rev C to Rev D indicates
changes in the Release notes only -- no changes were made to the product.

The next number represents the version in which a Known Anomaly was added to the release notes (for
example, V8.0).

FortiNAC 9.2.5 Release Notes
Fortinet Inc.

48



Copyright© 2024 Fortinet, Inc. All rights reserved. Fortinet®, FortiGate®, FortiCare® and FortiGuard®, and certain other marks are registered trademarks of Fortinet, Inc., in the
U.S. and other jurisdictions, and other Fortinet names herein may also be registered and/or common law trademarks of Fortinet. All other product or company names may be
trademarks of their respective owners. Performance and other metrics contained herein were attained in internal lab tests under ideal conditions, and actual performance and
other results may vary. Network variables, different network environments and other conditions may affect performance results. Nothing herein represents any binding

commitment by Fortinet, and Fortinet disclaims all warranties, whether express or implied, except to the extent Fortinet enters a binding written contract, signed by Fortinet's
General Counsel, with a purchaser that expressly warrants that the identified product will perform according to certain expressly-identified performance metrics and, in such
event, only the specific performance metrics expressly identified in such binding written contract shall be binding on Fortinet. For absolute clarity, any such warranty will be
limited to performance in the same ideal conditions as in Fortinet’s internal lab tests. In no event does Fortinet make any commitment related to future deliverables, features or
development, and circumstances may change such that any forward-looking statements herein are not accurate. Fortinet disclaims in full any covenants, representations, and
guarantees pursuant hereto, whether express or implied. Fortinet reserves the right to change, modify, transfer, or otherwise revise this publication without notice, and the most
current version of the publication shall be applicable.




	Overview
	Important
	Supplemental Documentation
	Version Information

	Compatibility
	Agents
	Web Browsers for the Administration UI
	Operating Systems Supported Without an Agent

	New Features
	New Features in 9.2.5
	New Features in 9.2.4
	New Features in 9.2.3
	New Features in 9.2.2
	New Features in 9.2.1
	New Features in 9.2.0

	Enhancements and Addressed Issues
	Version 9.2.5
	Version 9.2.4
	Version 9.2.3
	Version 9.2.2
	Version 9.2.1
	Version 9.2.0

	niKnown Issues Version 9.2.5
	Device Support Considerations
	Device Support
	Version 9.2.5
	Version 9.2.4
	Version 9.2.3
	Version 9.2.2
	Version 9.2.1
	Version 9.2.0

	System Update Settings
	Numbering Conventions

